Creating a Research Poster

What is a Research Poster?

A research poster is an organized, visual display of the main points of your research project. Typically, you present your poster in a poster session at a conference or seminar. Conference or seminar attendees will walk by your poster, study its contents, and ask you questions. You should be prepared to answer questions and to explain your project one-on-one frequently throughout the poster session.

To put it simply, a research poster is:

- A way to summarize and visualize your own research on a single large display
- Your opportunity to capture and convey the main points of your research to your audience

How you design your poster is up to you! Guidelines are offered to help you think about different aspects and the process of creating a poster for your research.

Who will see it and read it?

Your audience will depend on the context of the poster event. Generally, the audience is an assortment of colleagues, classmates, mentors, professors, and professionals as well as leaders in your field or a related field.

People walking by may glance at your poster, stop for a few minutes, or stop longer to hear you present, and some may ask you questions. An effective audience-friendly poster:

- **Presents your research in an organized and visually pleasing way.** Posters typically contain both text and graphics (charts, tables, lists, etc.).
- **Is self-explanatory.** In the case that you aren't standing by your poster, or if you are otherwise engaged in conversation, anyone walking by should be able to view your poster and understand the main points of your project.
- **Is easy to read.** Be sure your text and graphics are large enough that multiple people standing a few feet away can read your poster simultaneously.
- **Is concise.** Your poster should summarize your project quickly and efficiently. Avoid long paragraphs. Bullet points are often very effective. Figure out how you might present parts of your project through graphics. You should be able to explain your poster from start to finish in fifteen to twenty minutes, OR those who are reading it should be able to gather the main points in less than five minutes.
Undergraduate Research Week (May 21st-25th, 2018)

Undergraduate Research Week showcases undergraduate research and creative projects in the humanities, arts, social sciences, life sciences, physical sciences, and engineering. Events include oral presentations of student research, and presentations of research posters on Poster Day. Applications are due April 15, 2018 – share your research or creative project at an interdisciplinary conference!

Presenting Your Poster – a few suggestions

- Wear business casual attire. Wear comfortable shoes as you will be standing for long periods.
- Plan a few versions of your presentation that can be given in 1, 2, and 5 minutes in length to accompany your poster.
- Your verbal presentation should align with your visual presentation. You shouldn’t be jumping inconsistently across your poster.
- Be prepared for frequent interruptions. Viewers will ask you questions as you go along. They do not wait until the end of your presentation.
- Face your audience when speaking, but point to your poster.
- Start with the big picture. Emphasize your project goal. Walk the viewer through all the panels on your poster. Make sure that you end with a take-home message that brings the viewer back to your big picture.
- Remember: If it is on your poster, you should be prepared to talk about it.

Posters for Research Week

- Your poster can be sized up to 42 inches wide by 42 inches tall.
- Your poster will be attached to a poster board with pins provided by the Undergraduate Research Center on Research Poster Day.
- You can make a poster in PowerPoint and print it as a poster.
- Posters can be printed at UCLA or at a local printer. See pages 6-7 for printer locations and pricing.
- Posters can also be printed on standard printer paper (8.5 inches by 11 inches). Print the sections of your poster on standard paper, then attached each section directly to the poster board. Arrange the sections into columns and rows on your poster.
Elements of the Poster

Posters often have the following sections, which may vary by discipline:

- Title
- Author name (your name, faculty advisor’s name)
- Institution
- Abstract
- Background or Introduction
- Hypothesis or Argument or Research Question
- Methodology or Approach
- Figures or Images
- Results, Discussion, and/or Conclusions
- Future directions
- References (if needed)
- Acknowledgements

- **Title**: At the top of your poster, you should have a title that is brief but descriptive, and it should clearly indicate the nature of the project. In no more than 200 characters (approximately 30 words, including spaces), describe your research in succinct terms, reflecting the contents of your abstract. Use key words, and do not use abbreviations, non-English characters, or symbols. Capitalize the first letter of all words in your title. However, do not capitalize article words such as “a,” “the,” “and,” and “of,” unless the article is the first word of the title. The title should be easily readable at a distance of about 4-5 feet away. It should be written in “active tense” if possible.

- **Author(s)**: The first name should be the name of the poster presenter; after this, the authors are listed in the order of contribution to the work. Indicate the “presenting” author(s) (meaning you and any other authors who will present the work at Undergraduate Research Week) by writing these names in ALL CAPITALS. If it is appropriate to your discipline to list your faculty mentor as an author, you should list your faculty mentor as the last author. (Be sure to ask your faculty mentor if you are not sure!) Do not include titles or degrees such as Dr., Ph.D., etc.

- **Institution**: Below the list of authors, include your department and the university.

- **Abstract**: Your abstract must be at least 100 but no more than 1550 characters (approximately 225 words). The abstract should include introductory or background information, your argument or research question, the methods employed, and your results or conclusions. End the abstract by stating the significance of your research. Do not use symbols, non-English characters, italicized or boldfaced words, references, figures, or tables in your abstract.
• **Background or Introduction:** Present any background information necessary for the reader to understand your poster. Start with a general introduction to the field. Be brief, but include the important points to be sure the reader sees the relevance of your work. Bullet points are best, versus big paragraphs of text.

• **Hypothesis, Argument, or Research Question:** You should clearly state what you hypothesize based on the background information that you provided. You can include a model or diagram here to help explain the question you are interested in. State briefly your approach to answering your hypothesis. DO NOT go into details about methods in this section.

• **Methodology or Approach:** State briefly your methodology for answering your hypothesis or research question(s) (e.g. experimental methods) or your approach to crafting your argument or thesis (e.g. theoretical, disciplinary, etc. approach). You do not need to go into great detail here; it is often better to include details in figures or graphics.

• **Figures or Images:** Here you present the data or components of your project in visual form. Figures may be graphs, lists, tables, photographs, illustrations, diagrams, or other relevant graphics. Typically, each of your figures or graphics will have a title. If it is appropriate, you should also include a legend for each figure or graphic.

• **Results, Discussion, and/or Conclusions:** Here you state the results and conclusions of your project. Be brief and to the point. You should also indicate the significance of your project: what knowledge has your project added to your field? If it is appropriate, mention any alternative explanations for your results and possible explanations for unexpected results.

• **Future Directions:** If it is appropriate, you should explain what you plan to do next on the project. Do your conclusions lead you to a new question? Are you considering trying a new method to answer your original question?

• **References:** List all sources that you cite in the various sections of your poster. You should list your sources using the citation format appropriate to your discipline and project (MLA, APA, Chicago, etc.).

• **Acknowledgements:** If you are funded by a URC program, acknowledge your respective program (i.e. URFP, URSP, MMUF, etc.) as well as the grant you received. Otherwise, it’s highly recommended you acknowledge those who assisted you on or contributed to your research, which includes the funding source that paid you or provided the funds used to support your project.
Designing Your Poster

- **Font size**
  - Title – 72 point or larger
  - Author (you) – 48 point or larger
  - Headings – 48 point or larger
  - Content – 36 point or larger
  - Figure or Image captions – 20 point or bigger

- **Font choice**
  - Choose a clear font to read:
    - Arial
    - Calibri
    - Times New Roman
  - Do not use unclear fonts – examples include:
    - Comic Sans
    - Broadway
    - Harlow
  - Do not italicize text

- **Visual information** – Visuals can be figures or images. You can check the relevancy of your visual information by listing the visuals that you would use if you were describing your project with only figures or images – do they contribute to your presentation, or do they distract from it?
  - Figures – These should be clearly labeled according to the format used in your field or discipline (ex. APA, MLA, etc.)
  - Images – Make sure that images are high resolution – they should be at least 300 dpi (dots per inch) to avoid blurriness, and inserted (not pasted) to retain image integrity.

- **Color**
  - Text and background should contrast
    - Background color should make the content stand out
    - Font color should stand out but not be distracting
  - We strongly recommend that you have a white poster background with black or dark text and colorful, eye-catching figures. Having a white background saves ink, and posters with complicated background patterns are difficult for the reader to view.

- **Layout**
  - Posters are typically read top to bottom, left to right
  - Sections should be organized by columns
  - There should be three to four columns on the poster
  - Columns should be aligned
  - Text should be aligned
Creating a Poster Using PowerPoint
You can create a poster just like a normal PowerPoint slide—only bigger.

- **Set the size of ONE PowerPoint slide to the size of your poster**
  Under the File menu, go to Page Setup. For the size of the slide, type in the actual size of your poster. Your poster can be sized up to 42 inches wide by 42 inches high. Be sure to check with your poster printing location to determine the maximum poster dimensions that the location can print.

  You should always set the page size **before** you begin laying out your poster. Otherwise, you will likely have to go back and revise your poster layout.

- **Insert text**
  Add text to your poster by inserting Text Boxes (under the Insert menu) into your slide. Insert multiple Text Boxes for all of your different text components (title, abstract, etc.). Recommended font sizes are at least 72 point for your title, 48 point for your headings, 36 point for your text, and 20 point for figure labels.

- **Insert images and objects**
  The best way to add an image or object is to insert it via the Insert menu. Make sure your images are high resolution; otherwise, they will appear pixelated once they are enlarged and printed.

- **Adjust spacing, alignment, and size of pictures and text**
  Once you have inserted all of the poster elements, adjust the spacing, alignment, and size of pictures and text to create your desired layout. Make sure your poster is easy to follow.

- **PowerPoint Tip**
  Zoom in to work on detail and zoom out to work on arrangement of parts. Some functions of PowerPoint may not work when you zoom out to fit the whole poster on screen. Select an area to work on and zoom back in to 75-100% to make adjustments.

**Resources**
- UCLA Logo and brand identity information from the UCLA Library: http://guides.library.ucla.edu/c.php?g=223540&p=1480860 (Note: If you use the UCLA logo, it needs to be the official logo!)
- Ten simple rules for a good poster presentation: https://www.ncbi.nlm.nih.gov/pmc/articles/PMC1876493/
- A detailed 20-minute video on creating a poster using PowerPoint: http://undergradresearch.missouri.edu/resources/powerpoint-video.php
- A web resource for poster assembly presentation: http://www.swarthmore.edu/NatSci/cpurrin1/posteradvice.htm
UCLA Poster Printing Locations and Rates

If you would like to have your poster printed, contact one of the following printing locations. Please note that due to the high volume of posters being printed, you should allow for ample turnaround time!

Please also note that some locations may be fully booked by the time you contact them. Contact the printing location ahead of time to ask about printing availability and to schedule the time when you will drop off your poster file for printing. Be sure to ask your faculty mentor about preferred printing locations and any poster printing funds that are available.

Prices may change at the discretion of the printer – remember to confirm pricing prior to printing!

Locations

**UCLA Psychology Technical Services**
Franz Hall A544
Open Monday-Thursday
(310) 825-3430
techservices@psych.ucla.edu (contact 36-48 hours in advance by e-mail)
http://www.psych.ucla.edu/departmental-units/facilities/technical-services/graphics-and-media
42 in. x 42 in.: $38.65 (semi-gloss)

**UCLA Design and Media Arts**
Broad Art Center, fourth floor
issag@arts.ucla.edu
https://support.dma.ucla.edu/print/
$8.50 per square foot
42 in. x 42 in.: $103 (matte)
printing set-up fee may apply

**ASUCLA Bruin Custom Print Shop**
Ackerman Union on the A-Level (opposite Bruin Buzz)
(310) 825-3825
$6 per square foot (matte)
$2.50 per square foot (poster paper)
$7.50 per square foot (glossy)
42 in. x 42 in: $30.63 (standard poster paper), $73.50 (matte), $91.88 (glossy)
**UCLA Life Science Illustration Office**
Hershey Hall, Room 210
double@lifesci.ucla.edu
$17 per linear foot (glossy)
42 in. x 42 in.: $68 (glossy)

**UCLA School of Engineering**
Boelter Hall, Room 2685
http://www.matserv.ucla.edu/document-services/
matstdnt@ea.ucla.edu
$7.50 per square foot (glossy)
42 in. x 42 in.: $91.88 (glossy)

**UCLA Mail, Document & Distribution Services**
555 Westwood Plaza, Level B, Los Angeles, CA 90095
https://www.mdds.ucla.edu/document-services
(310) 825-0433
42 in. x 42 in.: $107.77 (matte or satin)

**Copymat Westwood**
10919 Weyburn Avenue, Los Angeles, CA 90024
Open Monday – Friday 9AM – 5PM
www.copymatwestwood.com
printit@copymatwestwood.com
(310) 824 5276
$7.50 per sq foot (satin, semi-gloss, or matte)
42” x 42”: $90 (satin, semi-gloss, or matte)
Arrangements can be made outside of normal business hours for pickup. Same day turnaround is available if needed at no extra cost.

**FedEx Office (formerly Kinko’s) in Westwood**
10924 Weyburn Ave, Los Angeles, CA 90024
http://local.fedex.com/ca/los-angeles/office-0897/
(310) 443-5501
$7.50 per square foot (matte)
$7.96 per square foot (heavy coat)
$12.50 per square foot (photo glossy)
42 in. x 42 in.: $91 (matte), $97.50 (heavy coat), $153 (photo glossy)
UCLA students will receive an additional 10% discount
Research Poster Examples

The Effects of Cumulative Life Stress on Cardiovascular Stress Reactivity
Alissa Der Sarkissian, Ji Min-June, Holly Pham, Anthony Portolesi, Alexandra Dupont, M.A.
Department of Psychology, UCLA

Background
- The theory of cumulative life stress suggests that environmental factors and significant life events can lead to cumulative life stress over time, which may contribute to health outcomes.
- The greater cumulative life stress an individual experiences, the greater the strain on their body, leading to changes in health outcomes.
- The purpose of this study was to examine the relationship between cumulative life stress and cardiovascular stress reactivity in young adulthood.

Methods
- The study included 127 participants aged 18-25 years, primarily female, who completed a comprehensive assessment of their life stress and cardiovascular reactivity.
- The cumulative life stress was calculated using a life events checklist, which measures the number and severity of life events over a 12-month period.

Results
- Participants who experienced a higher cumulative life stress had a greater increase in heart rate and blood pressure reactivity to stressors.
- These findings suggest that cumulative life stress may have long-term effects on cardiovascular health.

Conclusion and Implications
- The findings of this study support the cumulative stress model, highlighting the importance of considering the cumulative impact of life events on health outcomes.
- Future research should explore the mechanisms underlying the relationship between cumulative life stress and cardiovascular reactivity.

Acknowledgments
- We would like to thank our colleagues, Alexandra Dupont, Jacqueline Bower, and Larrice Dossel, for all of their help and support.

A Nation of Change: Mapping Race and Poverty in the United States
By Gabriella Anabella Santiago (UCLA)
Faculty Adviser: Professor Matthew Goss, Sociology
Stanford Center on Poverty and Inequality (CSP)

Research Question
- How have the economic circumstances for ethnic and racial groups in the United States changed from 2000 to 2010?

Background
- With the election of President Barack Obama, many have argued that the U.S. has become a post-racial society. However, race has become an unimportant factor in determining opportunity.

Methods
- Data were obtained from the American Community Survey (ACS) for the years 2000 and 2011.
- The analysis was conducted using SPSS software.

Findings
- The analysis revealed significant differences in poverty rates across different racial and ethnic groups.
- White populations had lower poverty rates compared to other groups.
- Latinx populations had higher poverty rates compared to other groups.

Initial Analysis
- The illustrations (below) display the percentage of persons living below the poverty line by race, Black, Latinos and Asian populations, respectively, in each state.

Moving Forward:
- Whether poverty status has increased for each racial and ethnic group remains uncertain, as many factors must be considered.
- The population size of each racial and ethnic group and their overall poverty status must be calculated in order to assess whether or not poverty status has increased.
- Additionally, an examination of how the economic and political climate at the time affected poverty status would be crucial for predicting future trends.
Implicit Stereotypes Among Latino Children
Kevin L. Bolz, Carl Gillis-O’Neal, Andrew J. Puligni
Department of Psychology, University of California, Los Angeles

Background
Previous studies have shown that Latinos show a group preference when compared to other ethnic minorities. It is not clear, however, whether their ingroup feelings are positive or negative. Other studies have shown that Latinos view themselves as less intelligent when compared to their white counterparts. In the few studies that have examined implicit measures of Latino stereotypes, the positive/negative valence of these stereotypes remained consistent from childhood to adulthood. Here, these studies have been extended to see if they have predominately examined ethnic stereotypes among only Whites.

The goal of the current study was to examine the development of Latino children’s implicit stereotypes about their ethnicity in general and academically.

Research Questions
- What are Latino children’s implicit ingroup attitudes towards their ethnicity?
- What are Latino children’s implicit outgroup stereotypes in academic?
- How do these attitudes/stereotypes differ at different ages?

Participants
- 120 Latino children
- 56.6% Female
- M_age = 9.39
- Grade Distribution:
  - 2nd: 48
  - 4th: 48
  - 5th: 24
- Participants were recruited from two schools in the Los Angeles area. One of the schools was predominantly Latino, and the other was ethically diverse.

Procedure
Following previous researchers, we assessed implicit stereotypes with a reaction time measure. Latino children were presented positive and negative words (e.g., nice, neat, sloopy, nerd, smart, mean) after being paired with photographs of children of their same ethnicity.

Results

- Latino in General

<table>
<thead>
<tr>
<th>Grade</th>
<th>M</th>
<th>SD</th>
<th>Significance Test</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd</td>
<td>-16.46</td>
<td>187.59</td>
<td>F(1, 47) = 7.16, p &lt; .01</td>
</tr>
<tr>
<td>4th</td>
<td>22.94</td>
<td>123.99</td>
<td>F(1, 47) = 1.26, p &gt; .30</td>
</tr>
<tr>
<td>5th</td>
<td>-17.35</td>
<td>166.06</td>
<td>F(1, 47) = .64, p &gt; .46</td>
</tr>
</tbody>
</table>

- Latino in Academics

<table>
<thead>
<tr>
<th>Grade</th>
<th>M</th>
<th>SD</th>
<th>Significance Test</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd</td>
<td>-15.90</td>
<td>159.22</td>
<td>F(1, 47) = .91, p &gt; .35</td>
</tr>
<tr>
<td>4th</td>
<td>38.68</td>
<td>156.96</td>
<td>F(1, 47) = 1.91, p &gt; .15</td>
</tr>
<tr>
<td>5th</td>
<td>26.07</td>
<td>114.36</td>
<td>F(1, 47) = 1.49, p &gt; .25</td>
</tr>
</tbody>
</table>

Discussion
- For their ethno group, Latino children demonstrated neither positive nor negative explicit stereotypes in general and in academics.
- Although the average implicit attitudes and stereotypes were close to zero, there was a wide range across participants.
- The task is reliant on fast reaction times, and therefore may not have been a valid measure for young children.
- Further research should consider using a different paradigm to look at the development of Latino children’s implicit group stereotypes.

Contact Information
For further information, contact: kbolz@ucla.edu

---

THE ASSOCIATION OF JOINT ENGAGEMENT AND SOCIAL INTERACTION
XUAN-THANH NGUYEN, KATHY GUEVARA, & TED HUTMAN, PH.D
UCLA CENTER FOR AUTISM RESEARCH AND TREATMENT, UNIVERSITY OF CALIFORNIA, LOS ANGELES

INTRODUCTION

The current study examines the association between joint engagement and social interaction in children with autism spectrum disorder (ASD) and typically developing (TD) children. Joint engagement refers to the interactive, reciprocal, and communicative behavior that occurs between individuals and is a key component of social interaction.

METHOD

Participants were recruited from the UCLA Autism Research and Treatment Center. Joint engagement was assessed through video recordings of play sessions between the children and their caregivers. Social interaction was measured using the Social Engagement Scale (SES).

RESULTS

Children with ASD had lower joint engagement scores compared to TD children. Social interaction scores were also lower in the ASD group, indicating a negative association between joint engagement and social interaction.

DISCUSSION

The findings suggest that children with ASD have difficulties in joint engagement and social interaction. Interventions targeting joint engagement may improve social interaction in children with ASD.

REFERENCES
